
الرحيم الرحمن الله بسم

  :     كتاب

ويفر دريم أدوبي دورس

  :     وترتيب     جمع

  ويفححرح     دريححم     واجهححححةح     شحححرحح

للمبتدئين               مبسط الشرح سيكون ال وبإذن تعقيد بدون ويفر دريم الدوبي برنامج واجهة بشرح سنبدأ

استخدام               من يُمكنك فالبرنامجج متكامل موقع لعمل المهمة البرامج من أصبح ويفر دريم الدوبي فبرنامج
.. لتصميمك   اللزمة الكائنات

واجهة البرنامج :



بشرحها        .. نبدأ البرنامج واجهة شكل على تعرفنا بعدما

شريط الدوات:

 

1-     . صفحتك     بأكواد العمل شاشة لظهار

2-     . عملك         بصفحة والسفل بالكواد العلوي الجزء قسمين لك يعرض

3-     . أكواد     بدون بالكامل العمل يعرض

4-     . اونلين   عملكج لعرض

5-     . العمل    صفحة اسم لكتابة

6-     . وأدارته       بموقعك للتحكم قائمةج ستظهر عليه بالضغط

7-     . المتصفح    على عملكج لعرض

8-     . تحديث  لعمل

9-     . الصفحة   كود لفحص



10-   . بالصفحة       المستخدمة التوابع أسماء جميع على يحتوي

11- . وإظهارها           كائنات إخفاء أو المسطرة قائمةجلظهار تظهر عليها الضغط بمجرد

  :  Insert  مجموعة القوائم المرفقة أي 

عملك  :     .     -1 تصميم لعمل خاصة العمل صفحة

2-      : الكائنات   إدراج لوحة

بأسفلها          شريط منهما لكل ستظهر القوائم من لكل اختيارك عند

اخترنا   :Textلنفرض كالتالي     الشكل لك سيظهر

: القوائم     دور لفهم الجدول وهذا

Common     والجداول والمرساة اللكتروني والبريد الرتباط يتضمن
وتأثير         والفلش فيروركس ال ام واتش والصور اللير ورسم

القوالب        وكائنات اوفر الرول بطريقة الصور على السهم
الوسوم     والتاريخ بأسماء وجدول والتعليق

Layout       لتحديد وأطارات اللير رسم و جداول على يحتوى
الصفحه

Text    لها تنسيق وعمل النصوص لكتابة
                           Tables       عند والكتابة بداخله الصور اضافة وبإمكانك جدول لعمل

خصائص       ستظهر روابط وعمل الجدول لحجم تحديدك
عملك   بأسفل الجدول

Frames    متنوعه لتقسيمات موقعك صفحة لتقسيم
Forms      والقوائم للرسال وفريم نصي وحقل نص لدراج

الفريم    داخل الصور ولضافة
Templates        يكون ان يجب شي كل وقبل لموقعك وارتباطات قوالب

عليهاج      للعمل لديك محفوظ موقعك
Characters     المفاتيح بلوحة موجوده ليست رموز لدراج

Media     فلشي ونص متنوعة وازرارفلشيه الفلش لضافة
لها    الصوت وإضافة والجافا

Head    اي للصفحه تجديد تعليقات  Refreshلعمل ولضافة
موقعك   عن ووصف

Script السكربت لضافة
Application  بموقعك سيرفر لعمل

شريط الحالة:



 

أل           -1 ام التش الكواد لك أن       HTMLيظهر اليمن الماوس بزر بإمكانك عملكج بصفحة
الكود                لك سيحدد اليسر الفأرة بزر ضغطت لو أما للكود تعديل بإضافةج أو ما كود تحذف

. ويظلله   عملكج بصفحة

المقاس                   -2 اختر قائمة ستظهر عليها الضغط خلل تصغيرهاجمن أو بتكبيرها العمل بحجم التحكم
. تريده  الذي

3-     . تحميله      ووقت عملك ملف حجم يظهر

 

   :  Page Properties  شرح تفصيلي لنافذة 

لقائمة   اختر   Modifyأذهب كليلك        Page Properties ثم رايت عملك ملف في مباشرة بالضغط أو
منها      اختر قائمة وستظهر الختصار   Page Propertiesبالماوس Ctrl + Jومفتاح

1 -Title.       :المتصفح بأعلى ستظهر الصفحة عنوان لكتابة



2-Background Image         :زر على بالضغط موقعك لخلفية صورة ملفك  Browseلرفاق اختر
. الصورة  وحدد

3-background    :الصفحة خلفية لون

4 -Text      :التالي للشكل انظر النص لون لختيار

5 -Links    :أخرى بصفحة الرتباط لون

6-Visited Links       :سابقا زيارته تم الذي الرتباط لون

7 -Active Links    :الضغط عند الرتباط لون

8-Left Margin + Top Margin + Margin Width + Height    =العمل مساحة إلى تشير
للعمل          والعرض طول تحديد مع أخرى جهة بأي أو بالعلى

9-Document Encoding    :الصفحة تشفير لتحديد

10 -reload  :الصفحة   لتحديث

11-Tracing Image           :كائن من تحريكها بسهولة رائعة مميزات فلها صورة لوضع تجربتها بإمكانك
آخر  . لكائن

12-Image Transparency   :الصورة شفافية لتحديد

13 -Document Folder     :بالفولدر ملفك عمل حفظ مكان

14 -Site Folder    :بالموقع ملفك حفظ مكان

  والصور     النصوص     إضافة



1 -Format              :طبيعي نص أو لعنوان ام فقرة لختيار منسدلة نافذة ستظهر عليها الضغط بمجرد

2 -A        : مابين لختيار سيتحول الحرف على الضغط  HTMLام  CSSبمجرد

للفونت            بالنسبة لكلهما منسق يعتبر وهو الحرف بجانب منسدلة قائمة ظهور وستلحظ

أخر         فونت اختيار بإمكانك أو الفونت من ماتريده فأختر

3 -Size   :الفونت حجم

4 -Text Color  :النص لون

 5 -Bold  :الخط لتعريض

6 -Italic   :مائل النص لجعل

اليسار-    7 إلى النص   لكتابة

الوسط-    8 إلى النص لكتابة

اليمين-    9 إلى النص لكتابة

واحدة-    10 بمحاذاة النص لعمل

11 -Link   :للنص تشعيبيج ارتباطج لعمل

نافذة-           12 في متكامل موقع وجود على يتوقف وعملها بالساعة سحب     Filesتسمى هو عليك ما كل
ويفر             الدريم ببرنامج رائعة ميزة وهيا البرنامج بنافذة لديك الموقع لملف الساعة شكل

النص-            13 مع ربطه المراد الملف لختيار نافذة ستظهر الفولدر على الضغط مجرد

14 -Target             :تفضل هل أخرى بصفحة المرتبط النص على الضغط عند لتحديد منسدلة نافذة ستظهر
مستقلة              جديدة بصفحه ام الصفحة بأعلى ام الصفحة بنفس ام مستقلة بصفحه الرابط فتح

15 -List Item             :النص بجانب التي الرقام أو النقاط شكل لتغير عليها الضغط بمجرد نافذة ستظهر



التعداد  -1  نوع

التعداد   -2  شكل لتحديد

الرقميج       -3 التعداد فيه سيبدأ الذي العدد لتحديد

الرقمي            -4 التعداد ترقيم بدأ لتحديد و جديد شكل أخر رقمي لكائن لتحديد

الخصائص-        16 عرض لختيار قائمة ستظهر الضغط  HTML or CSSبمجرد

للمساعدة-  17 زر

للجغة-    18 المباشرج  HTMLللتحرير

الخصائص-   19 لوحة لتصغير

  الصور     إضافة     طريقة   

الصور          لتحرير وبقدرته لعملك الصور إضافة بسهولة ويفر دريم يتميز

البرنامج             واجهة في شرحها سبق والتي الكائنات إدراج لوحة لفتح اذهب صورة لدراج

Common>Image

لقائمة    بالذهاب الختصار   Insert>Imageأو Ctrl + Alt + Iمفتاح

 

بأسفل               الصورة خصائص ظهور ستلحظ واحده مره عليها بالضغط قم الصورة إرفاق من انتهاءك بعد
التالي (    ) للشكل أنظر البرنامج



 

كلمة-          1 وبجانبها تحديدها تم التي الصورة لشكل توضيحي وبأسفلها   Imageمربع الصورة وحجم
الصورة     اسم لكتابة فارغ مستطيل

2 -Width ,        :عليها بالتعديل إمكانية مع الصورة عرض مع:    Heightمقاس الصورة طول مقاس
عليها   التعديل إمكانية

3 -Src             :لمعرفة لك بتحديدها يقوم وهو للصورة مسار وجود ستلحظ الصورة خصائص شكل من
سيظهر              للصورة وأسحبها الساعة شكل أيقونة على السحب بتجربة القيام بإمكانك بالبرنامج الصورة مسار

بالكامل    الملف مسار تحديد

4 -Link      :الصورة على تشعيبي ارتباط لوضع

5 -Alt               :كتابته تريد ما تحديد فبإمكانك ما اسم عليها سيظهر بموقعك الصورة على السهم تمرير عند

6 -Edit         :اليقونة على الضغط فبمجرد الصورة بخصائص تغيرك و    ..Editعند فورا تعديلها سيتم
Rest Size. كان       كما الصلية الصورة حجم لرجاع

7 -Map             :نقوم ولكي واحده لصورة متعددة ارتباطات بعمل أشبه فالمر للصور خرائط برسم خاص
للرسم       أداوت سنستخدم متعددة ارتباطات بعمل

8 -Pointer      :الصورة على المرسوم الشكال لتحريك  سهم



9 :Hotspot Tool            :للمضلع عشوائي رسم أو مستطيل أو مربع برسم الخاصة أدوات الثلث هذه
حاله                في الطار فتح مسار وتحديد عليها ارتباط لعمل جديدة خصائص لوحة ستظهر المربع رسم وبمجرد

الصورة   على النقر

10 -Vspace           ( بأسفله:    ( أو فوقه من يقع شي أي عن يبعد لكي فقط مخفي شفاف إطار لعمل

11 -Hspace             ( اليسرى:    ( أو اليمنى جهة من يقع شي أي عن يبعد لكي فقط مخفي شفاف إطار لعمل

12 -Target             :كانت إذا الصفحة فتح طريقة تحديد بإمكانك الصورة على ألتشعبي ارتباطج تحدد عندماج
البرنامجج         بواجهة شرحها وسبق الصفحة بنفس أو مستقلة صفحة

13 -Lowsrc              :يتم حين في بالموقع الصورة لك وستظهر صغير بمقاس صورة ترفق رائعة ميزة وهيا
الصلي   المقاس تحميل

14 -Border      :للصورة إطار لتحديد ما رقم نكتب

بالمنتصف-        15 أو يسار أو يمين الصورة محاذاة لتحديد

16 -Align   ..         :لتحديد قائمة لك ستظهر ومتقاربة متفاوتة بدرجات النص بجانب الصورة محاذاة لتحديد
النص  محاذاة

  Rollover     متغيره     صور     عمل     طريقة

اخرى             لصوره شكلها لتغير عليها السهم مرور بمجرد تتأثر صورة عن عباره وهي

الى   الزر    Commonاذهب اضغط  Rollover Imageثم

قائمةج   الى Insert> Interactive Images> Rollover Image أوأذهب

: التالي         بالشكل كما اختيارات عدة بها جديدة نافذة ستظهر



1 -Image name      :الصورة اسم عن ستكتبه ما وهو

2 -Original Image      :بالبداية ستظهر التى الصليه الصورة وهيا

3 -Rollover Image         :مباشرة ستظهر عليها السهم مرور بمجرد التى الصورة وهي

الصفحه          Preload rollover image اما-  4 فتح عندج منها والمقصد صح علمة عليها وضع تلحظ
فبمجرد        ظهورها قبل الثانيه الصورة تحميل سيتم

مباشرة         . الثانية الصورة ستظهر الولى الصورة على السهم مرور

5 -Alternate text            :التعليق سيظهر عليها السهم مرور بمجرد الصوره حول تعليق او نص لكتابة

6 -When clicked ,Go to Url         : تلقائيا الصوره على الضغط بمجرد تشعيبي ارتباط لعمل وهيا
المختارة    الصفحة لمسار سينتقل

  صورة     من     أكثر     عمل     طريقة

اطار                  من السهم خروج بمجرد او النقر بمجرد او السهم مرور بمجرد صورة من أكثر عمل لكيفية أما
الصورة

لج   زر   Commonأذهب  Navigation Barوأختر

 Insert> Interactive Images> Navigation Bar



1 -Nav Bar Elements   -  +       :بالسهم اما للحذف و للزيادة بإستخدام شريط من أكثر وضع بإمكانك
الشرطة     بين التنقل من فتمكنك

2 -Element Name  :للشريط أسم

3 -Up Image     :بصفحتك ستظهر التى الولى الصورة

4 -Over Image         :الولى الصورة على السهم مرور بمجرد ستظهر الثانية الصورة

5 -Down Image      :الثالثة الصورة ستظهر عليها النقر بمجرد

6 -Over While Down Image         :الرابعة الصورة ستظهر الثالثه الصورة على السهم مرور بمجرد

7 -Alternate Text            :التعليق سيظهر عليها السهم مرور بمجرد الصوره حول تعليق او نص لكتابة

8 -When clicked ,Go to Url         : تلقائيا الصوره على الضغط بمجرد تشعيبي ارتباط لعمل وهيا
المختارة    الصفحة لمسار سينتقل

9 -In Main Window       :الجديد المتصفح فيه فتح سيتم الذي وهو



10-Options :

 - Preload Image             *السهم مرور عمليةج يسهل حتى مباشرة المتصفح فتح عند كلها الصور لتحميل
الصور   اظهار لتسريع

 - Show" Down image "Initially         *الصفحة فتح حين بالمقدمه تظهر الثالثه الصورة لوضع

11 -Insert           :الفقي ام العمودي بالشكل الصور شريط ظهور بين لختيار منسدلة قائمةج بجانبها

12 -Use Table           :خصائص ظهور ستلحظ المر لهذا اختيارك وعند جدول داخل الصورة لرفاق
البرنامج   اسفل الجدول

  ثلاث     شرح     الدرس     هذا     في     سنتناول
  للفلاش     استخدامات

الفلش  –   –    إرفاق بالفلش أزرار الفلش النص

طريقة إضافة نص فلشي

وسريعة           .. سهلة بطريقة فلشيه نصوص إضافة ويفر دريم برنامج في بإمكانك

عملك       بحفظ تقوم ان يجب البدء قبل

الكائنات    إدراج زر       Mediaمن الدوات شريط من اختر  Flash Textثم

لقائمة   بالذهاب Insert> Interactive Images> Flash Text  او

: التالي      بالشكل كما جديدة نافذة  ستظهر



1 -Font    :ستكتبه الذي الخط نوع

2 -Size  :الخط  حجم

استخدام-    3 طريقة معروف أزرار

    - Bold  :الخط لتعريض

    - Italic   :مائل النص لجعل

اليسار -        الى النص   لكتابة

الوسط -        الى النص لكتابة

اليمين -        الى النص لكتابة

4 -Color   :النص لون لتحديد

5 -Rollover color          :النص علي السهم مرور عند سيظهر الذي النص لون لتحديد

6 -Text  :نصك لكتابة

7 -Show Font       : النص خانة داخل الفونت شكل نوعية لظهار

8 -Link     :النص على تشعيبي أرتباط لعمل



9 -Target             :لك ستظهر الصفحه بنفس ام مستقل بمتصفح النص رابط ظهور طريقة اختيار يمكنك
ماتريد     منها اختر منسدلة قائمة

10 -Bg Color     :الموقع وليس النص خلفيه لون

11 -Save As            :بالنترنت موقعك ملف مع تحميله ثم ومن بالجهاز لديك الفلشيج الملف لحفظ

طريقة إضافة أيقونات أزرار بالفلاش

الكائنات    إدراج زر       Mediaمن الدوات شريط من اختر  Flash Buttonثم

لقائمة   بالذهاب Insert> Interactive Images> Flash Button  او

1 -Sample           :على السهم تمرير بمجرد التأثير مشاهدة وبإمكانك بالفلش اليقونة شكل لمشاهدة
الصورة

2 -Style   :بالفلش الزرار  لختيار

3 -Button Text     :الفلشي الزر فوق النص لكتابة

4 -Font( الخط:    ( الفونت نوعية لختيار

4 -Size  :النص حجم

5 -Link      :الفلشي الزر على تشعيبي رابط لضافة



6 -Target          :الصفحة بنفس او جديد بمتصفح التشعيبي الرتباطج فتح مسار لتحديد

7 -Bg Color             :لون بدون لجعله اليقونه هذه على الضغط بإمكانك الفلشي الزرار لون خلفية لختيار

8 -Save As             :حفظ مكان واختيار السم كتابة بإمكانك او الفلشي الملف أسم تحديد سيتم تلقائيا
من    الفلشي browseالملف

الفلشي       الزر وتجربة عملك حفظ بإمكانك

بأسف           الفلشي الزر خصائص ظهور ستلحظ الزرار عمل من انتهاءك :لبعد التالي    كالشكل البرنامج

1 -Flash Button    :الفلشي الزر أسم لكتابة

2 -Width ,        :عليها بالتعديل إمكانية مع الصورة عرض مع:    Heightمقاس الصورة طول مقاس
عليها   التعديل إمكانية

3 -File    :للزر الفلشي الملف لرفاق

4 -Edit         :اليقونة على الضغط فبمجرد الصورة بخصائص تغيرك و    ..Editعند فورا تعديلها سيتم
Rest Size      كان كما الصلي الزر حجم لرجاع

5 -V space ..,,            ( بأسفله:    ( او فوقه من يقع شي اي عن يبعد لكي فقط مخفي شفاف اطار Hلعمل
space            ( او:    ( اليمنى جهة من يقع شي اي عن يبعد لكي فقط مخفي شفاف اطار لعمل

6 -Quality)            :تشاء ما اختر منسدلة قائمة ستظهر وسرعته الفلشي الزر دقة بعمل  Lowلتحديد يهتم
و   اما     Highالسرعه الزر بدقة و        Auto Lowيهتم الفلشي الزر ظهور سرعة على Autoيعمل

High        اختيار والفضل الفلشي الزر ودقة بسرعة  )Highيعمل

7 -Scale )      :خيارات لثلث منسدلة قائمة او:        Defaultبجانبه عليه التعديل دون هو كما النص يجعل
),( دقته  ),(No Borderتغير النص:            دقة قلة الى يؤدي مما الفلشي الزر بعرض النص ظهور سيتم
Excat Fit(             :جودته يفقد مما الفلشي الزر طول حسب على يتمدد النص بجعل سيقوم

8 -Align   ..         :لتحديد قائمة لك ستظهر ومتقاربة متفاوتة بدرجات النص بجانب الصوره محاذاة لتحديد
النص   محاذاة

9 -Bg      :الفلشي الزر خلفية لون إختيار بإمكانك

10 -Play         :إضغط ثم البرنامج في بصفحتك الفلشي الزر ليقافه Stopلتشغيل

11 -Parameters    :الفلشي للزر البرامترات لعمل



طريقة إضافة ملفات الفلاش

لقائمة   الختصار   Insert > Media > Flash  أذهب  Ctrl + Alt + Fمفتاح

بإمتداد         الفلشي ملفك منها أختر نافذة لك صفحتك     SWFستظهر داخل إدراجه وسيتم

  ويفر     بدريم     الجداول     عمل     طريقة

شريط    الى زر     Layoutاو   Tableإذهب أختر  Insert Tableثم

: التالي      للشكل انظر نافذة لديك ستظهر

1 -Rows    :الجدول أسطر عدد لوضع

2 -Columns    :بالجدول العمدة عدد لوضع

3 -Cell Padding       :بالبيكسل الخلية وأطار الخلية بين مساحة لتحديد

4 -Cell Spacing     :بالبيكسل الخليتين بين المساحة لتحديد

5 -Width( المئوية:    (    بالنسبة او بالبيكسل الجدول عرض لتحديد

6 -Border     ( ظاهر:        ( غير الخليه إطار سيصبح صفر رقم حددنا فإذا للخلية الطار عرض لتحديد
بصفحتك

البرنامج           ( بأسفل الجدول خصائص ظهور ستلحظ الجدول أضافة من انتهاءك التالي  عند للشكل  ):أنظر

Table ID -1   :الجدول إسم لكتابة

Rows -2 ,, الخلية:    أسطر العمدة:         Colsعدد إزدات كلما الرقم إزداد كلما الخلية أعمدة عدد



ًWidth -3 ,        :المئوية بالنسبة او بالبيكسل الجدول عرض إرتفاع:   Heightلتحديد طول لتحديد
المئوية     % بالنسبة او بالبيكسل الجدول

Cell Pad -4       :بالبيكسل الخلية وأطار الخلية بين مساحة لتحديد

Cell Space -5     :بالبيكسل الخليتين بين المساحة لتحديد

Align -6        :بالمنتصف او يسار او يمين الجدول محاذاة لتحديد

Border -7     :للخلية الطار عرض لتحديد

Clear Column Widths -8           :وضع إعادة سيتم الخاصية بهذه اما الخليه عرض حددنا بالسابق كنا
الخلية      عرض بإلغاء السابق الى الجدول

Convert Table Widths to Pixels -9    :بالبيكسل الجدول مساحة لجعل

Convert Table Widths to Percent -10       :المئوية بالنسبة مساحة سيزداد النقر تكرار بمجرد
الجدول   بعرض فقط

Clear Row Height -11      :بالسابق كانت كما الجدول طول لتحديد

Convert Table Height To Pixels -12     :البيكسل الى الجدول طول بتحديد يقوم

Convert Table Height To Percent -13      :المئوية النسبة الى الجدول طول بتحديد يقوم

Bg Color -14   :الجدول خلفية لون

Brdr Color -15    :الجدول إطار لون لتحديد

Bg Image -16       :الجدول بخلفية ما شكل او صورة   لرفاق

ترتيبح الخليا داخل الجدول

البرنامجج             بأسفل ستلحظ الجدول داخل الموجودة الخليا جميع بتحديد قم الخلية خصاص للظهار
الخصائص

Row -1  :الخلية أسطر

Merges Selected Cells Using Spans -2        * وبمجرد الزر تنشيط سيتم الخليا جميع تحديد عند
واحدة        بخلية الخليا كل بمدج سيقوم عليه الضفط



Splits Cell into rows or columns -3        *عليها الضغط وبمجرد تحديدها تم التى الخلية لتقسيم
والعمدة       الخلية لسطر بخصائص نافذة ستظهر

Horz -4( يسار:      (     او يمين او بالمنتصف الخلية داخل النص وضع لتحديد

Vert -5)     :عمودي النص وضع )أعلىلتحديد السطر        بمحاذاة او وسط او أسفل او

 ًWidth -6 ,        :المئوية بالنسبة او بالبيكسل الجدول عرض إرتفاع:   Heightلتحديد طول لتحديد
المئوية     % بالنسبة او بالبيكسل الجدول

No Wrap -7             :تلقائيا يقوم المساحة من كبيرا حيذ وأخذ النص كتابة فبحالة بالجدول رائعه ميزة
النص         على التأثير او تغير دون الخلية حجم  بزيادة

Header -8    :يعرض النص خلية     boldيجعل كل في بالمنتصف ويكون

 BG -9    :للخلية خلفية صورة لرفاق

 BG -10              :تحديدها بمجرد مختلف خلفية لون خلية بكل تحديد إمكانية مع الخلية خلفية لون لختيار

Brdr -11    :الخلية إطار لون لختيار

طريقة إدراج جداول جاهزة بالبرنامج

لقائمة   Commands>Format Tableإذهب

: التالي       للشكل إنظر جديدة نافذة لك ستظهر



الجدول       -1 نماذج إختيار

هنا         -2 تظهر النماذج شكل

3 -Row Color

First           :سطرين كل بعد بالترتيب سطرين أول الول السطر خلفية لون لتحديد

Second      :والرابع الثالث السطر خلفية لون لتحديد

Alternate               :ام ثلث ام سطرين ام سطر كل اللون ترتيب طريقة اختيار لتحديد منسدلة قائمة بجانبه
اسطر   اربع كل

4 -Top Row

Align     :الخلية داخل النص محاذاة لعمل

Style Text   :النص شكل  نوعية

Bg Color    :السطر خلفية لون لتحديد

Text Color   :النص لون لتحديد



5 -Left Col 

Align     :اليسر بالطرف النص محاذاة لتحديد

Style Text   :النص شكل نوعية

Border    :الجدول إطار عرض لتحديد

 Apply All Attributes to Td Tags   :كود عنه    TRللغاء بدل  TDوكتابة

  ويفر     دريم     برنامج     عن     وشاملة     متنوعة     أسئلة

ويفر؟-      1 الدريم ببرنامج الملفات إستيراد كيفية

قائمةج     لفتح مثل    File> Import إذهب ملفات إستيراد XMLو   Excelو   Wordبإمكانك

تشعيبي؟-    2 إرتباط عمل كيفية

الكائنات     إدراج لوحة الزر   Common من   Hyperlinkاختر

الرتباط       -1 نص لكتابة

للنص         -2 التشعيبي إرتباط ملف لختيار

جديدة              -3 بصفحة او مستقلة بصفحة التشعيبي الرتباط فتح مسار لختيار

الزر            -4 خلل من بالنتقال الرتباط ترتيب  TAPلتحديد

التعليق                -5 سيظهر عليه السهم مرور بمجرد مسار له الذي النص حول تعليق



بالحرف       -6 ماتشاء حرفك      أكتب على الصغظ على    +ALTفبمجرد ستفتح Enterوبالنقر
التشعيبي     الرتباط بمسار جديدة صفحة

إلكتروني؟-     3 بريد إرتباط عمل كيفية

الكائنات     إدراج لوحة الزر   Common من    Email Linkاختر

جديدة   نافذة ستظهر

 :Text    النص أسم أكتب

E-mail     :موافق إضغط ثم بريدك أرفق

ويفر؟-     4 بالدريم الزمن إضافة كيفية

الكائنات     إدراج لوحة الزر   Common من   Dateاختر

    : التالي      بالشكل كما جديدة نافذة   ستظهر

1-     Day Format      اليوم عرض لختيار

2-     Date Format     التاريخ شكل لتحديد

3-      Time Format     ل او التاريخ عرض لتحديد



للموقع            -4 صفحتك تحميل بوقت للتاريخ حفظ بعمل سيقوم

؟-      5 جدول داخل جدول أضع كيف

زر                 نسحب ثم أخر جدول به إرفاق المراد الجدول بتحديد قم أخر جدول داخل جدول Tableلوضع

الجدول   داخل

؟       -6 والسطر العمدة بحذف أقوم كيف

إذهب    بحذفهم تقوم لكي

 Modify > Table > Delete Row   الختصار Ctrl + Shift + Mمفتاح

Modify > Table > Delete Column   الختصار   + -Ctrl + Shiftمفتاح

؟          - 7 أفعل فماذا الرتباطاتج فحص من التأكد أنسى الحيان ببعض

الى        إذهب بصفحتك الرتباطات عمليةجفحص File > Check Page > Check Linkلعمل

الختصار  Shift + F8  ومفتاح

عن                 تقرير كشكل نافذة لك ستظهر ثم موقع لديك يكون ان يجب الرتباطات على التعديل يتم ولكي
. المزدوج       بالنقر عليها التعديل وبإمكانك الرتباطات أخطاء

أمر     -8 أعمل ؟   Refreshكيف لصفحتي

وأختر      الكائنات إدراج لشريط   Head > Refreshإذهب

جديدة     نافذة لك ستظهر

الصفحة        -1 تحديث وقت لتحديد

ما           -2 صفحة لفتح التحديث عند الفعل لختيار

الصفحة         -3 نفس بتحديث الفعل لختيار



  ويفر     دريم     برنامج     في     الموجودة     الوامر     أهم
  الموقع     عمل     وكيفية

نريد              .1 الذي للموقع مخطط رسم هو عمله يجب شيء أول
التنقل      وطرق والروابط للصفحات بالنسبة عمله

القائمة        .2 نفتح موقع لنشاء خطوة نكتب  Site > new siteأول ثم
في           يظهر ل السم هذا أن العلم مع للموقع المناسب السم

. المتصفح  نافذة
صفحة    .3 المر   htmlلنشاء خصائص    < newنعطي باختيار نقوم ثم

واختيار          اليميني الزر على الضغط طريق عن الصفحة page تلك
properties

هذا          ويكون الصفحة لهذه اسم فيه ندخل حوار مربع فيظهر
محركات          في منه يستفاد حيث الصفحة عمل على للدللة السم

لرضية          صورة وضع أو للصفحة اللون نختار أن يمكننا البحث
ولون        التشعبية الروابط ولون النص لون واختيار المستند

والمربع    .   بزيارتها قمنا التي أبعاد  Marginالروابط لتعيين
شريط       من البعاد تعيين والسهل وذلك  window sizeالصفحة

والمر    .   للبرنامج الرئيسية الصفحة لوضع  tracing imageفي هو
. المتصفح       في تظهر ل فقط استرشادية صورة

الوامر              .4 لوح من صورة إدراج نختار المستند في صورة لدراج
Common  .

باستخدام           .5 الصفحة عمل في البدء Layout tables & cellsيتم
ولترتيبها    الصفحة لتخطيط وذلك

أننا        Rolloverالمر   .6 حيث الوقت نفس في صورتين لتحميل وهو
وهذا         الثانية الصورة فتظهر الصورة على المؤشر تضع عندما

الوامر      لوح في موجود commonالمر
المرين             .7 كل فلاش وأزرار فلاش أفلم إضافة أيضا يمكن

الوامر     لوح في commonموجود
إمكانية           .8 يعطينا مما الفلاش من نص إضافة أيضا يمكن كما

صفحة         إلى الرتباط وإمكانية فوقه الماوس تمرير عند التلوين
أمر      طريق عن وذلك الوامر    flash textأخرى لوح في الموجود

common
9.     URL: Uniform Recourse locators 

أنواع:   ولها الروابط

الداخلية          · internal links or local linksالروابط



على        الموجودة الموقع وصفحات مستندات بين الربط وهو
المحلي    الخادم جهاز نفس

إجراء:        نريد الذي العنصر أو النص نعين له   الطريقة الرتباط
ونعين         الخواص مربع في الموجود الرتباط لمربع نذهب ثم

المرتبط  الملف

القفز          ·  Anchorروابط

نفس        داخل المختلفة المواضع بين والتنقل للقفز وتستخدم
صفحة,         داخل محدد موضع إلى للنتقال تستخدم كما الصفحة

الموقع    نفس في أخرى

مرحلتين:      على العملية هذه تتم الطريقة

حيث              - الصفحة في إليه القفز نريد الذي موضع إنشاء أول
ونذهب         إليه القفز نريد الذي المكان في المؤشر نضع

في      named anchorللمر  الوامر لوح ضمن الموجود
إدخال       invisibleالتفريعة  منا يطلب مربع لنا فيظهر

ترك        عدم مراعاة مع السم فندخل الموضع السم
هذا         إنشاء فيتم موافق نضغط ثم الحرف بين مسافات

الموضع

الموقع              - إلى منه القفز نريد الذي العنصر إلى نذهب ثانيا
   ( إلى    (  نذهب ثم مثل نص ونختاره أنشأناه الذي السابق
الخانة        في السفل في الموجود العنصر Linkخصائص

التالية   بالطريقة ونكتب

#name of  anchor

أنشأناه         الذي الموضع اسم كتابة دقة إلى النتباه ويجب
مسبقا

فيجب           أخرى صفحة في بمكان ربط إنشاء نريد كنا إذا أما
الموضع         إلى الصفحة اسم وإضافة سبق بما القيام علينا

مثال  ...  أنشأناه   index.htm#name of anchor        الذي

الخارجية          · External Linksالروابط

أخرى     بمواقع للربط وهي

الطريقة:



الروابط        في عملنا كما يكون الخارجية الروابط لنشاء
في         كامل العنوان نكتب أننا في الفرق ولكن الداخلية

العنوان  :  شريط http//:www.yahoo.com  مثال 

اليميل          · e-mail links روابط

أن          عليه بالضغط نريد الذي العنصر تحديد أو باختيار نقوم
المفتاح         على نضغط ثم اللكتروني البريد نافذة لنا يفتح

insert e-mail link     الوامر لوحة فنكتب commonمن
إيميل       رابطة إنشاء فيتم كامل بشكل العنوان

Nul links  & script linksروابط         ·

معين        كود لتشغيل معينة خواص العناصر لعطاء تستخدم
سكريبت   جافا باستخدام

للح    بالنسبة العلمة :    #Nul linkالطريقة بوضع في  وهي
 linkالمربع 

10.                        Navigation bar

بين          للتنقل مفاتيح عدة على يحتوي شريط عن عبارة وهو
المختلفة    الموقع وصفحات أجزاء

يتغير         التي الصور من مجموعة من الشريط هذا وتتكون
المستخدم    استخدام حسب مظهرها

ولنشائه:

الشريط         إدراج نريد الذي المكان في الصفحة في نضغط
navigation bar     المر على نضغط من insert navigation barإليه

الوامر    commonلوحة

العنصر          أو المفتاح اسم بإدخال نقوم ثم حوار مربع فيظهر
ملفات         مسار الخرى الخانات في ويظهر الشريط في الول

يلي           لما تباعا ستظهر والتي مسبقا إنشاءها تم قد التي الصور

الولى    الخانة على     up imageفي تظهر التي الصورة وهي
بالمؤشر        عليه الضغط قبل الطبيعي وضعه في المفتاح

الثانية    الخانة على     over imageفي ستظهر التي الصورة وهي
فوقه     المؤشر تحريك عند المفتاح

الثالثة    الخانة عند     down imageوفي ستظهر التي الصورة وهي
المفتاح   على الضغط



الرابعة    الخانة التي   over while down imageوفي الصورة وهي
عليه         الضغط بعد المفتاح على المؤشر تحريك عند ستظهر

. السابقة       الخانات جميع استخدام الضروري من وليس

11.                        image map

ربطة          لجل وذلك الصورة من محدد جزء لتعيين طريقة وهي
آخر     موقع أو أخرى بصفحة

الخصائص          في فيظهر الصورة على الضغط طريق عن ذلك ويتم
وذلك          حرة أو هندسية أشكال عدة رسم إمكانية تعطيك مربعات

الدوات         هذه وتدعى الصورة من موضع أي  hotspotلحديد

كتابة          علينا فيجب جديدة خصائص لنا يظهر الموضع تحديد وبعد
الخانة     في ما الموضع        ,mapاسم بهذا علقة له يكون أن ويجب

الخانة      في الكتابة يجب ستظهر     Altوأيضا الكتابة هذه أن حيث
أخيرا        ,   و الصورة على المؤشر تمرير حال في المتصفح في

الخانة           في إليها النتقال نريد الذي الصفحة اسم كتابة linkيجب

بالح        محددة أماكن عدة وجود حال عندنا   hotspotوفي يظهر فانه
  , بعض     وهناك وغيرها كالمحاذاة الخرى الخصائص بعض

فيجب         اليميني الزر أي السريعة القائمة من نأخذها الخصائص
لذلك  التنبه

12.                        Jump Menu

عدة          على تحتوي قوائم عن عبارة وهي القفز بقوائم وتسمى
الموقع       صفحات بين بسهولة للتنقل تستخدم خيارات

عمل    يتم من        linkحيث أو الموقع نفس من أخرى صفحات مع
الموقع  خارج

إلكترونية        رسالة عمل من القوائم تلك تمكننا كما

نذهب:           ثم فيه النشاء نريد الذي المكان في المؤشر نضع الطريقة
الفرعية    اللوحة المر      formsإلى ونضغط الوامر لوحة jumpمن

menu          الخر تلو ألواح فيه فنكتب حواري مربع لنا فيظهر

. توضيح          عن عبارة وهو فعال غير الول الخيار يكون وعادة

13: جدول.  إدراج

المر     طريق عن الوامر    Insert tableيتم لوح commonمن



للجدول     خصائص عدة لنا فيظهر

Cell padding        يتم التي المكونات بين تحدد التي المسافة وهي
بالخلية      المحيط والطار الخلية في إدراجها

Cell spacing      الجدول خليا بين المسافات لتحديد تستخدم

للجدول      Bg Imageالمر  كخلفية صورة لتحديد وهو

وإمكانية        الصور كإدخال المكونات لضافة إمكانية الجداول وتعطينا
اكسل       كملفات أخرى ملفات من المكونات استيراد

البيانات.   14 الفرعية "           Formsنماذج اللوحة من تؤخذ الوامر جميع
form" الوامر    لوح من

·          : البيانات   نموذج إدراج أول يجب البيانات نماذج formإنشاء
        , إدراج  نريد الذي المكان في المؤشر فنضع المستند إلى

المفتاح       على نضغط ثم فيه لوحة   insert formالنموذج من
, المستند,        داخل اللون احمر متقطع إطار فيظهر العناصر

أول      نجد الخصائص إلى يفيدنا  form nameوبالنسبة وهذا
جافا        كود داخل لستخدامه للنموذج اسم إعطاء في

 , ويجب        إليه التحكم أوامر إضافة عند سكريبت بح سكريبت
. قبل        من مستخدم غير السم هذا يكون أن

التطبيق     Actionوتستخدم  أو الكود عنوان لتحديد
, البيانات    نموذج لمعالجة المستخدم

نقوم       إلكتروني بريد كرسالة النموذج بيانات ولرسال
الكلمة   اللكتروني    :mailtoبكتابة البريد بعنوان متبوعة

  , إضافة      فيتم إليه النموذج بيانات إرسال سيتم الذي
للخاصية    كقيمة .Actionالعنوان الكود   داخل

>form name="form1" method="post"
action="mailto:info@homearab.com<"

Method        بيانات تناول بها سيتم التي الطريقة لتحديد وهي
  , فالختيار  البيانات القيم   Postنموذج لرسال يستخدم

 , أما         رسالة طريق عن البيانات نموذج في إدخالها يتم التي
Get      البيانات نماذج وقيم البيانات لرسال فيستخدم

الح    بعنوان ,   URLملحقة استخدام    يفضل ول فر السير إلى
العناوين       Getالطريقة  إن إذ الطويلة البيانات نماذج مع

URL        حذف الممكن فمن الحروف من معين بعدد محدودة
      , مع    نستخدمها ل أن يجب كما البيانات تلك من جزء



كبيانات        السرية من عالية درجة تتطلب التي البيانات
,        َ سريا مؤمنة غير الطريقة هذه لن الئتمان كروت

إلى         إرسالها سيتم التي البيانات نوع تحديد يجب كما
بشكل         إرسالها ليتم البيانات نموذج خلل من فر السير
للخاصية,         القيم تحديد طريق عن ذلك ويتم  ,enctypeسليم
الح          لغة في الكود في الخاصية هذه بكتابة HTMLونقوم

السطر   Formضمن

>form name="form1" method="post"
action="mailto:info@homearab.com" enctype<""=

الموجودة        القيمة تكون عندما العادية البيانات نماذج وفي
الخانة   الفتراضية   postهي   methodفي القيمة فان

صحيحة   trueهي   enctypeللحقل  أي

الخانة        داخل الموضوعة القيمة كانت إذا عبارة actionأما
قيم        إرسال سيتم الذي اللكتروني للبريد عنوان عن
سيتم        الفتراضية الحالة في فانه إليه البيانات نموذج

الرسالة         مع مرفق منفصل ملف ضمن القيم هذه إرسال
فنقوم         نفسها الرسالة ضمن القيم هذه إرسال أردنا فإذا

 enctypeللخاصية    text/plainبكتابة 

>form name="form1" method="post"
action="mailto:info@homearab.com"

enctype="text/plain<"

15    : العنصر.    إضافة بعد البيانات نماذج فانه   formحقول المستند إلى
يمكننا           ل إذ بداخله البيانات نماذج عناصر إضافة في البدء بإمكاننا

الح       بدون البيانات نماذج عناصر الضافة    formإضافة تكون أن ويجب
العنصر    .formبداخل

المر            · على نضغط بداخله السم لكتابة حقل لنشاء والن
insert text field    الوامر لوحة المر   formمن لهذا ويوجد

   , نستعين     أن ويمكننا بدقة اختيارها يجب خصائص عدة
للترتيب   بالجداول

·        List & Menu       العناصر لوح من المر هذا ,Formيضاف
بين        من واحد خيار لعمل المستخدم لتمكن وتستخدم

الخيارات   من العديد

التي       Listوتستخدم  الخيارات عدد في التحكم نريد عندما
ارتفاع        تحديد يمكننا حيث بالقائمة بعرضها التحكم نريد

نقوم        التي الخيارات عدد يزداد وعندما القائمة هذه



 , وتمكننا      الجانب على تمرير شريط فيظهر بإضافتها
.  Listالقائمة  واحد       وقت في اختيارات عدة عمل من

لختيار       Menuأما  أي محدودة خيارات عمل عند فتستخدم
على        نضغط للقائمة الخيارات ولضافة فقط واحد عنصر

إظهاره      List valueالمفتاح  نريد الذي النص بكتابة فنقوم
الح      حقل في القائمة الحقل   item lableداخل valueوفي

. السيرفر       إلى سترسل التي القيمة بكتابة نقوم

Radio Buttons & check boxes   لتسهيلحعملية وتستخدم
طريقة          في هو بينهما والفرق البيانات نموذج ملئ أثناء الختيار

فالح   بين      radio buttonsالعمل من واحد خيار لختيار تستخدم
أما    اختيارات خيارات     check boxesعدة عدة فاختيار فتسمح

المطلوب    المربع باختيار  وذلك

الح   الوامر      radio buttonsلعمل لوح من باختياره formsنقوم
في         معين اسم إدخال فيجب المناسبة الخصائص إعطائه ويجب

    , الحقل     في والكتابة الخصائص مربع ضمن السم checkحقل
value  , الوضعية      واختيار السيرفر إلى سترسل التي القيمة

إعطاء   (      يجب انه إلى النتباه ويجب الختيار لمربع الفتراضية
في          إدراجهم يتم حتى الختيار مربعات جميع إلى ذاته السم

.( منها      الختيار سيتم التي المجموعة نفس

       العمليات في للتحكم وتستخدم البيانات نماذج مفاتيح إنشاء
المفاتيح         هذه استخدام ويمكننا البيانات نماذج على تتم التي

إلى         النموذج في بادخالها المستخدم قام التي البيانات لرسال
حقول,        لعادة البيانات نماذج مفاتيح تستخدم كما السيرفر

يتم         أخرى بمهام استخدامها أو الفتراضية الوضعية إلى النماذج
إنشاء       (   ويمكن سكريبت جافا مثل معين كود بكتابة تعريفها

إدراج      طريق عن وذلك معين الوامر     مفتاح لوح من صورته
forms.(       اسكريبت بالجافا المر كتابة يجب  وبالتالي

يتبقى           .16 بداخله الحقول وادراج البيانات نموذج بانشاء قمنا ان بعد
المستخدم           يقوم التي البيانات ان من للتاكد الخطوات ببعض نقوم ان

      , البريد    عنوان ادخل قد يكون كأن سليم بشكل تتم بادخالها
      , المر   طريق عن ذلك ويتم الصحيحة بالصيغة Validateاللكتروني

form   منBehaviors inspector       الح طريق عن إليها نصل التي
Launcher     على نضغط الشريط   formثم كل  Tag selectorمن لختيار

اللوحة  ,    ومن الدخالت المفتاح    +Behaviorsاماكن على نضغط
المر      ونختار التحكم اوامر اختيار   validate formلظهار يتم ثم

القائمة         من اسمه بحسب بيانات حقل كل  .named fieldخصائص

17   : الطارات.  تستخدم الويب    Framesالطارات صفحات لتخطيط
      , عدة    نفتح ان نستطيع الطريقة وبهذه أجزاء عدة إلى وتقسيمها



ابقاء           مع واحد اطار في بالحرى أو النافذة نفس في صفحات
      , بما    معا الطارات تلك تنسيق ويتم حالها على الخرى الطارات

الداخلي        frame setيسمى  التركيب تعريف طريقه عن يتم حيث
الطارات         عدد مثل الصفحات هذه عن اللزمة والمعلومات والخواص

الذي          المصدر وملف الطارات وابعاد الصفحة هذه في ستظهر التي
   , عرض         يتم ول الخرى البيانات من والعديد إطار كل داخل فتحه يتم

Frame set         بيانات لحفظ تعريف ملف عن عبارة لنه المتصفح داخل
   , الطارات      أما المستند داخل الطارات عرض كيفية فهي Framesعن
الصفحة          في اطار وكل المستند داخل معرّفة مناطق عن عبارة

صفحة    لعرض من,      htmlيستخدم نختار الطارات إنشاء بعمل وللبدء
التفرع    العناصر الطارات     Frameلوحة من مجموعات عدة فنجد

, ايضا          عليها التعديل يمكننا حيث طريقها عن بالنشاء نبدأ الجاهزة
الزر         على أول بالضغط نقوم الطارات أحد لوحة   altولختيار من

نحدد           ثم ومن اختياره نريد الذي الطار على الضغط ثم المفاتيح
بالضغط          يظهر الذي الخصائص مربع طريق عن الطار هذا خصائص

يقوم.        ctrl + f3على  البرنامج لن الحفظ عملية إلى النتباه ويجب
      , يقوم      اطار أي نعرف ان ونستطيع مستقل ملف في اطار كل بحفظ

سيحفظه          الذي الطار يحدد البرنامج بأن وذلك الن بحفظه البرنامج
. اسود  باطار

التحكم.   18 الحدااث      Behaviorsأوامر من خليط عن عبارة وهي
events  والفعالactions 

معينة         actionsوالفعال  مهام لنجاز سكريبت جافا كود عن عبارة هي
الحداث   الفعل         eventأما لتنفيذ يحداث أن يجب الذي الشرط فهو

actions. 

إضافة   الفعل         behaviorوعند تعيين يتم فانه مستند من عنصر إلى
action  والحداثevent  , البدء      ويمكن الفعل هذا ببدء سيقوم الذي

هذه          ترتيب يمكن كما الحداث نفس بواسطة أفعال عدة بتنفيذ
الفعال.

اللوحة   الوامر     behaviors inspectorوتستخدم لتعديل أو لضافة
التحكم    بأوامر على     behaviorsالخاصة نضغط اللوحة هذه ولظهار

الشريط    behaviorsايقونة  على,    launcherمن اللوحة هذه وتحتوي
  , الضغط        وعند التحكم أوامر لتعديل أو لضافة تستخدم مفاتيح عدة

بالفعال  "+"     قائمة تظهر المفتاح والقائمة,   actionsعلى المتاحة
ً      show events forالفرعية  تبعا المتاحة التحكم أوامر لختيار تستخدم

للمتصفح.

التحكم    أوامر عرض       behaviorsومن في تتحكم ان يمكن التي
المر     الطارات داخل المر    set txt of frameالبيانات هذا ويعمل

معين          نص ككتابة تحديدها يتم أخرى بمحتويات الطار محتويات بتغيير
    , التي       بالبيانات التحكم ويمكن معين حداث عند ليظهر المر هذا ضمن



المر       طريق عن الطار بداخل المر    go to urlتعرض هذا يعمل حيث
ويتم            معين إطار داخل أو النافذة نفس في آخر مستند فتح على

, الوقت          نفس في اطارات عدة محتويات تغيير نريد عندما استخدامه
ملف      لفتح المكانية يعطينا من     htmlحيث اطار كل في مختلف

الطارات.

المستند :      Layersالطبقات.  19 داخل العناصر مواقع لضبط تستخدم
ذلك             غير أو كتابات أو صور أو نماذج على الطبقات تحتوي ان ويمكن

  , إدراج        وبمجرد بداخلها أخرى طبقات على تحتوي ان يمكن كما
ظهورها         في التحكم من نتمكن سوف الطبقات داخل العناصر

تحريك         امكانية إلى بالضافة ظهورها ترتيب في وايضا واختفائها
الزمني      الشريط نافذة باستخدام وتستخدم Time linesالطبقات

وذلك        المستند وتخطيط لتصميم الحيان اغلب في الطبقات
من,          النتهاء بعد جداول إلى الطبقات نحول ان ويمكن لمرونتها

, الطبقات          تدعم ل التي المتصفحات داخل عرضها يتم لكي التصميم
المر       طريق عن الطبقات إنشاء الوامر    insert layerويتم لوح من

common. 

  المتداخلة يتم     Nested layersالطبقات طبقة عن عبارة وهي
داخل          المؤشر وضع طريق عن وذلك أخرى طبقة داخل رسمها

المر      اختيار ثم ومن المنسدلة   layerالطبقة القائمة insert  من
لستخدام        الحاجة دون الطبقات داخل مباشرة الرسم ويمكننا

المنسدلة   في      insertالقائمة خاصية تعديل يجب أول ولكن
المنسدلة        القائمة فتح طريق عن وذلك ثم  editالبرنامج ومن

اختيار    preferencesاختيار  ثم تفعيل    layersومن ثم ومن
 .nestingالمربع 

        : جديدة  خواص عندنا يظهر طبقة أي اختيار عند الطبقات خواص
الخانة          هي الخواص هذه اهم ومن الخصائص لوح idفي

لغات          في الكتابة عند يفيدنا وهذا للطبقة اسم لدخال وتستخدم
  , والخانة   سكريبت كجافا لتعيين  topو    leftالبرمجة تستخدم

, للصفحة       واليسر العلى والطرف الطبقة بين  المسافة

,  Bg imageومن  والخانة      الطبقة لخلفية صورة اختيار clipيمكننا
  , والخانة       الطبقة من للظهور معينة مساحة لتحديد -Zتستخدم

index       داخل ظهورها يرتب رقم الطبقة لعطاء تستخدم
تكون         ان يمكن القيمة وهذه الخرى للطبقات بالنسبة المتصفح

      , في   بعضها فوق المتوضعة للطبقات وبالنسبة سالبة أو موجبة
لها      التي الطبقات فان خلف    Z-indexالمستند ستظهر صغيرة

التي   .z-indexالطبقات كبيرة 

اللوح        طريق عن واختفائها الطبقات بظهور التحكم ويمكننا
layers panel " اضغطF2" ظاهرا     يكن لم اذا



يمكننا          طريقها وعن طبقة كل يسار على عين توجد حيث
. باختفائها    أو بظهورها التحكم

حال       overflowوالخانة  في للطبقة سيحداث ما لتحديد تستخدم
  , الخيار       أما الطبقة ابعاد عن بداخلها الموجودة المحتويات كبر

Tag.       الطبقة لنشاء العنصر نوع لتحديد فيستخدم

الزمني   للطبقات      Timelineالشريط تحريك عمل خلله من يمكن
      , لصورة    المصدر الملف تغيير يمكن كما عناصر من تحتوي بما

تحكم      أمر تشغيل أو ول      behaviorمعينة معينة زمنية فترة بعد
وضعهم           بعد من إل المستند داخل نص أو صورة تحريك يمكن

      , من  ابتداء الميزة هذه المتصفحات وتعتمد الطبقات داخل
    , التحكم  لوحة ولظهار الرابع على   time lineالصدار نضغط

 .shift + F9الختصار 

حركة  الذي         ولعمل المكان في الطبقة بوضع نقوم ما لطبقة
        , في   الحركة قنوات احد إلى الطبقة نضيف ثم منه البدء نريد

في        ووضعها للطبقة والسحب بالضغط وذلك الزمني الشريط
       , التي  الطبقة اسم يحمل شريط إضافة فيتم الزمني الشريط

      , اضافة     تم قد انه ونلحظ الحركة قناة إلى باضافتها keyقمنا
frame    , على     نضغط الحركة ولنشاء وآخرها القناة اول في

في         ووضعه الطبقة بسحب نقوم ثم الخير الحركة مفتاح
         , مسار   عن يعبر خط إضافة تم قد انه فنلحظ نريد الذي المكان

شريط,        من اكثر باستخدام بالحركة التحكم ويمكننا الحركة
اليميني         الزر على بالضغط الزمنية الشرطة إضافة ويتم زمني

.add time lineواختيار 

  , لعرض       وتستخدم الحركة قنوات كح أخرى خيارات أيضا ويوجد
, المستند        داخل التحريك عليها يطبقّ التي والصور الطبقات

التحريك     شرائط أيضا تستخدم  Animation barولدينا التي
الشريط          داخل عنصر كل عرض فترة أو الزمنية المدة لتحديد

اكثر           على تحتوي أن يمكن الحركة قنوات من قناة وكل الزمني
. مختلف   عنصر من

الذي         بالشكل التحريك شريط إلى الحركة اضافة ايضا ويمكننا
منحني,           بشكل ما لطبقة الحركة تكون ان اردنا اذا فمثل نريد

الحركة          باضفة نقوم مستقيم بشكل تكون ان من keyبدل
frame ,         كما للماوس اليمن الزر طريق عن الحركة شريط إلى

المفتاح        على الضغط طريق عن ذلك المكان  Ctrlيتم وتعيين
    , منحني     بشكل الحركة ولنجعل الحركة شريط على نريد الذي

للطبقة          السحب مع نضغط ثم اضفناه الذي الحركة مفتاح نختار
من         الطبقة مسار تحول فنلحظ نريده الذي التجاه في

. منحني   إلى مستقيم



التحكم    قناة التحكم    Behaviorsاما أوامر لظهار وتستخدم
behaviors  , تعديلها       ويمكن معين وقت عند تشغيلها يجب التي

. مزدوجا    ضغطا عليها بالضغط

الخانة   العرض   ”FPS “Frame per secondوتستخدم معدل لتحديد
  , والخانة        الثانية في عرضها يتم التي اللوحات عدد auto playأو

, المتصفح        داخل الصفحة تحميل عند المباشر للعرض يستخدم
.loopوالخانة  توقف      بدون العرض لستمرار وهي

: الطبقات   ظهور  Show - Hide layersحالة

عدا          ما المستند في الفرعية الطبقات جميع اخفاء نريد عندما
نقوم         الماوس مؤشر في عليها نمر التي الفرعية الطبقة

ان,         نريدها التي الفرعية للطبقة الرئيسية الطبقة نختار بالتالي
الوامر          لوح نفتح ثم عليها الماوس مرور حال في تظهر

Behavior inspector  +    المر لضافة الشارة على ونضغط

 show hide layers   الجزء باختيار  named layersومن نقوم
الماوس          مرور عند تظهر ان في نرغب التي الفرعية الطبقة

المر    ونعطيها باخفاء    showعليها نقوم باقي hideوبعدها
فقط   الفرعية الطبقات

فيه          سينفذ الذي الحداث بغيير نقوم ذلك من النتهاء وبعد
إلى      سابقا بها قمنا التي التطبيقات

 on mouse over        الفرعية الطبقات كل اخفينا قد نكون وبذلك
, الماوس        عليها تمر التي عدا ما المستند في

المتصفح          تفتح عندما انك وهي ذلك في مشكلتين يوجد  ولكن
الماوس         تحريك حين إلى ظاهرة ستكون الفرعية القوائم فان

المر       فيبدأ الرئيسية القوائم احدى به   hideإلى قمنا الذي
       , اللوحة  فتح هي المشكلة لهذه والحل بالتفعيل layersسابقا

   , المشكلة       أما العين طريق عن الفرعية الطبقات جميع واخفاء
القائمة           فوق من الماوس مؤشر تحريك بعد من انك وهي الثانية

فرعية           قائمة آخر فان الصفحة من آخر جزء أي إلى الرئيسية
    :    , شفافة  طبقة بانشاء هي المشكلة تلك ولحل ظاهرة ستظل

عرضي        بشكل ممتدة وتكون الفرعية الطبقات أسفل جديدة
    , أمر      بادراج نقوم ثم الفرعية الطبقات كل اسفل تمتد بحيث

show hide    اللوح الطبقات     behaviorمن جميع باخفاء ونقوم
الحداث,     نعين ثم .on mouse overالفرعية

الح          بتحويل نقوم أن نستطيع أننا بالذكر الجدير إلى  layersومن
        , مع  العمل عند نحتاجه أن يمكن ذلك لن وبالعكس جداول

. الثالث         الصدار في كما الطبقات استخدام تدعم ل متصفحات



الطبقات          تحول بأن لك تسمح ل المستندات من أنواع وهناك
العداد          سابقة نماذج على مبنية تكون التي وهي جداول إلى

template        , على يحتوي الذي المستند تحويل يمكن ل كما
متداخلة   في       nested layerطبقات يوجد ان يمكن ل انه حيث

    , جداول   إلى التحويل وطريقة متداخلتان خليتان الجدول
المنسدلة      القائمة بفتح هي  .convertواختيار  modifyوبالعكس

 النماذجTemplate       : المستند حفظ طريق عن النماذج عمل يمكن
المجلد       داخل وضعه ويجب نموذج تغيير  templateكصيغة وعدم

    , تحديد,      طريق عن إل للتعديل قابلة غير تكون والنماذج مكانه
النافذة         فتح طريق عن وذلك نريدها التي ومن Assetsالمناطق

المفتاح        بضغط طريقها عن النموذج فتح نضغط   editثم ثم ومن
  , طريق         وعن فيه التعديل نريد الذي المكان نحدد أو الصورة على

المر     نأخذ السريعة القائمة

new editable region. معين    اسم ونعطيها

 المكتبةlibrary         : ومن فيها ما عنصر حفظ من تمكننا أنها حيث
     , هي      الخاصية هذه من ونستفيد آخر مستند أي في ادراجه ثم
يتعدل          سوف فانه المكتبة في الساسي الملف نعدل عندما اننا

    , الخاصية     هذه إلى ونصل فيها المستخدم المستندات جميع في
النافذة    طريق  . Assetsعن

   باستخدام الكتابات الخاصية :   HTML stylesتنسيق هذه تعطينا
ثانية         مرة تطبيقها يمكننا بحيث للكتابات تنسيقات حفظ امكانية

    , عن       العملية تلك وتتم أخرى مستندات في أو المستند نفس في
النافذة    فتح الشريط   HTML stylesطريق ثم Launcherمن

المر          اختيار ثم المستند في مكان أي في من new styleالضغط
النافذة   الحواري     Html Stylesأسفل المربع لنا Defineفيظهر

HTML style        هل نختار كأن نريدها التي الخيارات بعمل ونقوم
بالكامل          الفقرة على أم حددناه الذي النص على التطبيق نريد

من   الجزء,   Apply toوذلك ما  when applyingويستخدم لتحديد
الفقرة         أو الكتابات على التنسيق تطبيق عن عمله سيتم

   , اختيار   فعند المستند داخل فانه add to existing styleالمختارة
الموجود         التنسيق حذف دون الجديد التنسيق تطبيق يتم سوف
فان          الخصائص بين تشابه وجد ان ولكن مسبقا النص على

  , اما   الجديد للتنسيق يتم   clear existing styleالولوية سوف فانه
   , اختيار        يتم وهكذا منه بدل الجديد ووضع قديم تنسيق أي حذف

       . ما  تنسيق المستندات احد في صادفنا واذا الخرى التنسيقات
فما           أخرى اماكن التنسيقحفي هذا تطبيق وأردنا لفقرة أو لنص

اختيار          ثم الفقرة أو النص ذلك تحديد سوى new styleعلينا
المطبقة         التنسيقات جميع فيه ويوجد حواري مربع لنا فيظهر

وبعد          بحفظه ونقوم فقط السم نغير فعندها النص ذلك على
. عليه        الضغط بمجرد التنسيق ذلك تطبيق نستطيع  ذلك



   باستخدام الكتابات CSS styles  ////Csascading styleتنسيق
sheet         :التي التنسيقات أو الخواص من مجموعة عن عبارة وهي

الواحد          المستند داخل النص من معين بجزء التحكم في تستخدم
الوقت          نفس في مستندات لعدة الكتابات بخواص التحكم في أو

خاصة          ومعايير اساليب على تحتوي نصية ملفات عن عبارة وهي
وتتميز    الكتابات يمكن  HTML Stylesعن  CSS styleبتنسيق بانه

تعديل          بمجرد انه كما الوقت نفس في مستندات بعدة ربطها
المرتبطة         الملفات جميع في تعديله سيتم فانه التنسيق هذا

خاصية   (  تلقائيا التنسيق اصدارات    CSS stylesبهذا مع تعمل ل
.( الرابع      الصدار قبل هي التي  المتصفحات

من    انواع ثلثة external /linked/ styleل الو CSS Styles  وتوجد
sheet        في والمعايير التنسيقات كتابة يتم الطريقة هذه وفي

المتداد        الملف هذا وياخذ منفصل نصي ولتطبيق CSSملف
النافذة         نفتح فاننا المستند على الملفات هذه CSS stylesمثل

الح    في على    Launcherالموجودة نضغط attach style sheetثم
     , خاصياته     في التعديل اردنا واذا تطبيقه نريد الذي الملف ونختار

ببرنامج          بفتحه وذلك ذاته الملف طريق عن ذلك نستطيع فاننا
النافذة     note padالح  طريق عن النحو   CSS stylesأو على وهي

على:    نضغط الذي     edit style sheetالتالي الملف نختار ثم ومن
. فيه          التعديل نريد الذي التنسيق نختار ثم ومن تعديله نريد

الرموز      Embedded style sheetالثاني  كتابة يتم النوع هذا وفي
على        وهي نفسه المستند داخل بالتنسيق الخاصة والمعايير

   : على  نضغط التالي النافذة   new styleالنحو CSS styleمن
مختلفة          أنواع ثلثة عمل من فيه يمكننا حواري مربع فيظهر

وهي

Custom style (class-(      على مختلفة تنسيقات لتطبيق يستخدم
 , ولنشائه       الخرى الفقرات دون المستند في الفقرات بعض

المفتاح    على نختار    new styleنضغط ثم من  )class(ومن ونختار
define in          المستند هذا ضمن التنسيق هذا حفظ نريد كنا اذا فيما

استخدامه          من لنتمكن منفصل ملف في حفظه في أو فقط
  ,       , بجانب  ونجد نريدها التي التنسيقات نختار ثم ومن مرات عدة

التنسيق   *       هذا ان تعني العلمة وتلك العلمة التنسيقات بعض
في     يظهر لن  .Explorerربما

Redefine HTML Tag-   تنسيق لعادة من    يستخدم عنصر أي
اللغة   ننسى      HTMLعناصر ول المستندات لتنسيق المستخدمة

الح   ,   Tagاختيار الخانة      ونختار عليه نعدل أن نريد thisالذي
document only  . المستند      داخل الجديد التنسيق حفظ ليتم

 -Use CSS Selector       تركيبات من معين تركيب لتنسيق يستخدم
 .HTMLاللغة 



البرنامج        inline styleالثالث  داخل انشاؤها يتم ل الطريقة هذه
الجزء         داخل بها الخاص الكود كتابة يجب الخاص bodyولكن

بالمستند.

     باستخدام المستند خلفية في العناصر :  CSSالتحكم تنسيق إن
الح  نستخدم      HTMLبلغة ولذلك المكانيات لتنسيق CSSمحدود

تنسيق          في أكبر ودقة أعلى تحكم درجة توفر لنها العناصر
فان,          للخلفية صورة اضافة أردنا اذا المثال سيبل فعلى العناصر

ستكون         والنتيجة الصفحة خصائص في صورة وضع هي الطريقة
 , أما          لها تنسيقات أي يوجد ول الصفحة خلفية في مكررة صورة

طريق   الح      CSSعن تحدد أن هي تختار   bodyفالطريقة newثم
style    نختار ثم this documentونختار  redefine html tagومن
only  ثمok   نختار ونختار    backgroundثم القائمة من

الصورة         نوسّط أن نستطيع أننا حيث نريدها التي التنسيقات
. ذلك         وغير المنتصف في تثبيتها يمكننا كما تكرار  وبدون

    بح والكتابات بالطبقات التحكم  CSSتمكننا:  CSSالتحكم من
    :  , معين    لجزء اختيارنا عند مثال دقيق بشكل والطبقات بالكتابات
عن           له خلفية تعيين نستطيع ل فاننا فقرة داخل الكتابات من

الح     لغة أوامر الح ,       HTMLطريق طريق عن ذلك عمل يمكننا بينما
CSS      على بالضغط نقوم ذلك الح   new styleولعمل نافذة من
CSS   نختار , Make custom styleثم ثم     اسماً نعطيه أن ولننسى

ok      الح منه نختار مربع للخلفية  Backgroundفيظهر ونعطي
//       , غيرها   أخرى خيارات إعطاء أيضا ويمكننا نبغاه الذي اللون

ل        *    أن يمكن علمة بجانبها التي الخيارات بان نتذكر ان ويجب
  ,// ثم   المتصفح في جديد    okتظهر تنسيق لدينا يظهر  فيتكون

الح    نافذة على       CSSفي ونضغط نريده الذي النص بتحديد فنقوم
ان       .    يمكن وكذلك النافذه من بانشائه قمنا الذي التنسيق اسم

بنفس         والكلمات السطر و الحروف بين المسافات بتغيير نقوم
باختيار     ولكن السابقة من   Blockالطريقة   .Backgroundبدل

الح       طريق عن أيضا يمكننا تحديد    CSSوالن إطار Borderعمل
وتعيين         مختلفة بألوان الطار هذا تلوين يمكننا كما للطبقات

باختيار       سماكته ولكن السابقة الطريقة نفس هي والطريقة
Border.

الح    تمكننا على       CSSكما المرور عند المؤشر شكل تغيير من
, المستند    داخل معين الطرق     عنصر نفس هي والطريقة

باختيار    ولكن  .Extensionالسابقة

    : يجب    الموقع نشر قبل الموقع لختبار المتصفحات استخدام
شائعة         المتصفحات على سليم بشكل يعمل أنه من التأكد

بشكل         تعمل الرتباطات ان من التأكد يجب كما الستخدام
قمنا,           قد نكون ان اول يجب الختبارات بهذه البدء وقبل سليم



المحلي    الموقع في //   Local siteبتعريف مشروح هو كما
   ,// القائمة  ومن الول المر    fileالمستوى check targetنطلب

browsers         ان نريد التي المتصفحات هذه احد المربع من ونعين
ونضغط      طريقها عن بالفحص تقرير   okنقوم عندنا فيظهر

الميزات         بعض او الصفحة هذه في الموجودة الخطاء يتضمن
     , جانبه     والى الخطأ سبب فيظهر المتصفح هذا يدعمها ل التي

  , هذا       ولجراء المشكلة فيه توجد الذي والكود سطره رقم
المحلي          الموقع على أو الموقع داخل مجلد على Localالختبار

site      على بالضغط الموقع بفتح الشريط  show siteنقوم من
launcher       جميع لختبار للموقع الرئيسي المجلد فنختار

المر     نأخذ ثم  .Check target browsersصفحاته
   : المر    يستخدم الموقع داخل الرتباطات check linksاختبار

//, نصل          منه جزء في أو الموقع في المنفصلة الروابط عن للبحث
    ,// المر      هذا يستخدم كما ملف القائمة طريق عن المر لهذا

مستند          أي مع المرتبطة غير الملفات عن تقرير htmlلعطاء
    , الداخلية   الرتباطات البرنامج ويختبر بالكامل الموقع داخل

 فقط.
       : بتحديث  يقوم البرامج أن من الرغم على الرتباطات تعديل

اسمها         تغيير أو موضعها بتغيير نقوم التي للمستندات الروابط
:  , مثال         الروابط على يدوي بتعديل للقيام أحيانا نحتاج أننا إل

   , بطلب    فنقوم بأخرى صفحة تغيير الشريط   show siteنريد من
Launcher    القائمة نختار change link site wideثم  siteثم

نريد          الذي القديم المستند اسم فيه نكتب مربع لنا فيظهر
 , وبذلك,        الجديد المستند اسم فيها نكتب الثانية والخانة استبداله

        ً تبعا الصفحات كل في الرتباطات تعديل تلقائيا يتم أيضا
     . البريد  استبدال يمكن الطريقة وبنفس الجديد للتعديل

      , المربع   من الولى الخانة في فنكتب جديد بآخر اللكتروني
التالي      // بالشكل القديم البريد عنوان :mailtoالحواري

info@homearab.com//      الصيغة بنفس الجديد العنوان ونكتب
. الخر     الحواري المربع في  السابقة

       بحسب صفحتين احدى فتح امكانية البرنامج هذا يعطينا
متوافقه         الولى الصفحة تكن لم فاذا نستخدمه الذي المتصفح

    , طريق      عن ذلك ويتم الثانية الصفحة ستفتح فانها المتصفح مع
 . check browserونختار  behaviorالمر 

  العناصر هو :    Meta Elementsاستخدام الول لغرضين تستخدم
البحث         محركات تتعرف لكي معينة صفحات عن معلومات تقديم

      , للمتصفح   أوامر ارسال هو الثاني والغرض النترنت شبكة على
استبدال           أو تحديث عمل أو تحميل اعادة مثل معينة مهام لنجاز
منع          او معينة زمنية فترة بعد اخرى بصفحة الحالية الصفحة

على          الكااش داخل الحالية الصفحة من نسخة عمل من المتصفح
   , العنصر  ويوضع المستخدم الراس   Metaجهاز headداخل

العناصر,      لعمل طريقتان وتوجد القائمة   metaللمستند بفتح إما
الموجودة      insertالمنسدلة  العناصر احد اختيار او head tagsثم



التفرع      واختيار الوامر لوح نضغط   headفتح ,insert metaثم
ومن     حواري مربع عنصر     attributeفيظهر كان اذا منه نحدد

meta        وفي الحالية الصفحة عن وصفية معلومات على يحتوي
نختار    الحالة خاصة,      nameهذه معلومات على يحتوي أنه أو

الحالة          هذه وفي المتصفح خلل من السيرفر الى أوامر بارسال
اختيار   الخانة,   http equivalentيتم نوع   valueوفي بتحديد نقوم

المعرفة         القيم بعض وهناك العنصر هذا مع المستخدمة البيانات
شريط      لها والتي البرنامج منفصل  property inspectorداخل

الخانة),   key word, refresh, descriptionمثل ( يتم contentوفي
الخانة         في تحديدها تم التي بالقيمة المرتبطة المعلومات كتابة

value        ,للمتصفح امر اعطاء اردنا اذا المثال سبيل وعلى
navigator        يقوم عندما بالكااش الحالية الصفحة حفظ بعدم

فنقوم        المتصفح هذا طريق عن الصفحة بعرض الستخدم
الخانة   http equivalentباختيار  الخانة   attributeمن valueوفي

الخانة   pragmaنكتب  فيتم okثم  no cashنكتب  contentوفي
الجزء        داخل العنصر لهذا الخاص الكود  .headاضافة

لح    بالنسبة عدد   key word & descriptionأما لزيادة تستخدمان
محركات         طريق عن البحث بعمليات يقومون الذين الموقع زوار

معينة          كلمات على يحتوي الذي الموقع هذا على والعثور البحث
العنصر     باستخدام باضافتها الح,   key wordسنقوم keyولضافة

words      الوامر لوح من عليه فيه    headنضغط نكتب مربع فيظهر
تكون          ان الفضل ومن بإنشائه قمنا الذي الموقع تصف كلمات
البحث         محركات بعض لن وذلك بعناية ومختارة محدودة كلمات

. معين    أحرف عدد لها

الح   الوامر      descriptionولعمل لوح من عليه فيظهر headنضغط
. للصفحة      موجز وصف فيه نكتب مربع

العنصر    لعمل تحديث      refreshوالن أو تحميل اعادة ووظيفته
   , يمكننا      طريقه وعن محددة زمنية فترة بعد الحالية الصفحة

المعروضة    slid show or animationعمل  المحتويات تغيير أو
الن  ,       سنعمل المثال سبيل وعلى المتصفح slide showداخل

الملفات          هذه من ملف وكل التوالي على ملفات ثلثة لعرض
كل          بتتابع الملفات هذه عرض واردنا بداخله صورة على يحتوي

المر,     على فنضغط المربع     refreshثانيتين ومن الوامر لوح من
delay   , الخانة    ومن الزمنية الفترة refresh this documentنكتب

حددناه         الذي الوقت بحسب الصفحة نفس تحميل اعادة سيتم
حددناه,          الذي الوقت بعد آخر مستند فتح نريد وعندما سابقا

الخانة       من مساره بتحديد نقوم سابقا   go to URLفاننا فعلنا كما
المر    طريق الوامر   refreshعن لوح تلك,  head من ونكرر

على           نحصل وبذلك أخرى ملفات لفتح نريد أننا حال في العملية
slid show. 



       الموقع باعداد نقوم ان يجب النهاية لتحميله Remote siteفي
السيرفر  .  على

تعالى   بعونه تم
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